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Preface The CATIA Version 5 System Space Reservation product enables you to easily define a space reservation network that can be done at a preliminary or detailed design stage for tubing or cable routing. The main focus of the product is to allow defining of the space networks that can be used to route physical objects such as cables or tubes. It allows early detection of space or other types of conflicts so that they do not emerge at design time. The product allows you to segregate space networks, which means that there can be clearly defined primary and backup systems/path rules. System Space Reservation provides an efficient, cost-effective way to create space for tubing or cabling design, and for review and validation. The initial design can be expanded, evolved, and modified to continue the design process. The entire process is accomplished through a simple, highly intuitive interface, combining traditional 2D layout paradigms with full CATIA 3D capabilities to allow you to build a 3D digital representation of the design. The product can be used with other digital plant design products, such as CATIA Version 5 Systems Routing and Plant Layout, to satisfy plant design requirements. These products, together with the CATIA Version 5 product portfolio, provide you with the complete ability to design and optimize your plant layout. The System Space Reservation User's Guide has been designed to show you how to create the required space for tubing or cabling design. Based on design factors and various industries and domains, different design approaches may be undertaken. This book provides an overview of the product and aims at illustrating specific design procedures to aid your design efforts.



Using This Guide This book describes how to use the CATIA Version 5 System Space Reservation product. Before you read it, you should be familiar with basic CATIA Version 5 concepts such as document windows, standard tool bars, and view tool bars. Information about the user interface and basic tools common to all CATIA Version 5 applications is available in the CATIA Version 5 Infrastructure Users Guide. To get the most out of this guide, you should start with the tutorial in the Getting Started section. The remaining sections of the book describe in detail the procedures for using all of the features of the System Space Reservation product. The procedures are divided into basic, advanced, and customization sections.



Getting Started The following short tutorial provides an introduction to the CATIA Version 5 System Space Reservation product, It is intended to give you a feel for the product's capabilities in a few step-by-step scenarios, which are listed below.



These tasks can be completed in about 15 minutes.



Entering the System Space Reservation Workbench This task explains how to enter the System Space Reservation workbench.. 1. Click on the Start menu. 2. Select Equipment & Systems -> System Space Reservation.



The System Space Reservation workbench is loaded, and an empty CATProduct document is opened.



Set Working Units This task describes how to set working units. 1.



Select Tools -> Options command.



2. 3. 4. 5.



Select Units tab from the General menu Select the Length Magnitude and set the units to Foot. Select the Area Magnitude and set the units to Square foot. Select the Product menu from the left side fo the Options window. Select the Plant Layout tab. Set the Grid Step field to be 1 ft. This sets the default grid step for all the snapping capibilities provided with the Plant Layout product. 8.Click the OK button to complete the customization of the working units.



6. 7.



8.



Create an Equipment Reservation You create an equipment reservation by activating the element, usually a reservations network, under which you will place the reservation. An equipment reservation is created when you want to set aside space in which you will later place a physical object, such as machinery or furniture. Item reservation is the general term for this type of reservation. You can create your own terminology or use the ones that are included in this product - equipment, product or resource reservation. 1. In the specifications tree, double-click the network to make it the active element. 2. . Select the Item Reservation button. 3. Select Equipment Reservation as the type of reservation. 4. To define the size of the reservation, key in these values: X Length 20 ft Y Length 15 ft Height 10 ft 5. Click anywhere in area to define a location for the equipment reservation. 6. Zoom the window in to get a closer view of your equipment reservation. 7. To see the newly created equipment reservation in the specifications tree, click on the plus sign (+) next to the network name. The illustration below shows the specifications tree and the newly created equipment reservation.



Basic Tasks The basic tasks for laying out a design using the System Space Reservation workbench are listed below.



Using Basic Layout Tools The following procedures describe the basic tools available in the System Space Reservation product for general layout functions.



Changing the Current Axis This task shows you how to change the current axis. By default, the current axis is located on the active area or item reservation. If neither an area nor an item reservation is active, the current axis is located on the parent area for the active element. The current axis is the reference point by which elements are routed and placed. It is also the reference point from which an element's position is determined (as displayed in the X,Y,Z fields on the Definition dialog box for an element). 1. Do either of the following to change the current axis:



Place your cursor on the Change Current Axis icon to the element you want to use as a reference. Click the Change Current Axis icon you want to use as a reference. The axis is displayed on the element.



and drag it



and then select the element



Making an Element Active This task shows you how to make an element in a drawing active. An element is active when it is highlighted in blue in the specifications tree, as shown below. You make an element active for various reasons. One reason is to create another element as a child of the active element. Any new element you create will become a child of the active element.



1. You can make an element active by following any of these steps: Double-click the element in the drawing or in the specifications tree. Select Activate Parent icon to make the active element's parent active. To activate an area, select the Activate Area icon and then select the area. 2. Optional. You can change the display of elements that are not active using the Toggle Dimming Mode icon on the General Environment Toolbar: When Dimming Mode is on, elements that are not active are dimmed. When Dimming Mode is off, inactive elements are not dimmed.



Using a Step Grid This task shows you how to define the increments for a grid to control the routing or placement of elements in a drawing. 1. and key in a value for the grid units. Select the increment field 2. Set any of the following step grid options on the General Environment Toolbar: Snap to steps off current axis Coordinates displayed are relative to the current axis. Snap to steps off last position Coordinates displayed are relative to the current axis until you indicate a point; after that, coordinates displayed are relative to last point that you indicate. Snap to Drafting elements If you have defined construction planes in the drawing, you can also use these options: Snap to XY construction planes Snap to elevation planes (in the Z direction) Snap to all construction planes



Aligning Elements This task shows you how to align elements in your layout. You can align the center or the sides of an element to a reference plane that you define. You can also rotate an element to align it with a reference plane. 1. Select the element(s) that you want to align. 2. Select the icon for the type of alignment you want to perform: Align Sides: aligns the sides of two or more elements Align Center: aligns the centerlines of two or more elements Rotate to Align: rotates elements on the axis to align them Distribute - See Distributing Elements 3. Define the plane to use as a reference for the alignment. If you have an offset plane defined it will be used as the reference plane. If you do not already have the offset plane defined do the following: a. Place your cursor over a geometric element that defines the plane (e.g., a construction plane, boundary, area contour, item reservation). As you move the cursor, a small white rectangle is displayed to show the selectable planes, as shown below. A line normal to the rectangle shows the direction in which the alignment would be performed.



If you do not see the white rectangle, zoom out from the drawing. The white rectangle cannot be displayed if the element under your cursor is displayed too small. b. Click to select the plane. The selected elements are aligned along the plane.



4. Optional. If you selected Align Sides you can indicate (press the left mouse button) to adjust the element as described below. If you selected Align Sides, indicating flips the aligned elements to the other side of the reference plane. If you selected Rotate to Align, indicating rotates the aligned elements in increments of 90 degrees. Click any button in one of the tool bars to exit the alignment command. If you want to continue with the alignment command using the same reference plane then select another element in the model.



Using Item Reservations The following procedures describe how to use item reservations.



Creating an Item Reservation This task shows you how to create an item reservation. 1. Select the Item Reservation button



.



The Item Reservation dialog box is displayed.



2. Specify the type of reservation you want to create:



3. Specify the size of the item reservation by keying in these values: X Length Y Length Height 4. Specify the visual mode for the item reservation: Box Axis



5. Specify the location for the item reservation.



Moving an Item Reservation This task shows you how to move an item reservation. 1.



Make the item reservation's parent the active element. See Making an Element Active.



2. 3.



Click the item reservation. The item reservation is highlighted. Place your cursor at the desired location on the item reservation. As you move the cursor over the item reservation, visual "cues" are displayed to show how you can move it. A plane is displayed when the cursor is over a line to show that you can move the item reservation along that line. A cross hair is displayed when the cursor is on a corner. From a corner, you can move the item reservation in any direction.



4.



Drag the item reservation to a new location.



5. Select the Update button



to see the modification.



Resizing an Item Reservation This task explains how to resize an item reservation. 1. Right-click the item reservation. 2. Select the item reservation object on the pull-down menu.



If the item reservation is empty, this menu is displayed: If the item reservation contains a resource, this menu is displayed:



3. Do any of the following to change the size:



To key in a new size, do the following: . Select Edit -> Definition.. The Item Reservation Definition dialog box is displayed. b. Key in new values for the X Length, Y Length, and/or Height. c. Select OK on the Item Reservation Definition dialog box.



To resize the item reservation using the cursor, do the following: . Select Edit -> Definition. Manipulation handles are displayed on the item reservation. b. Place the cursor over one of the handles and drag it to resize the item reservation. c. Select OK on the Item Reservation Definition dialog box. To resize the item reservation so that it just encloses the resource it contains, select Edit -> Update Dimensions.



Rotate item reservation using the definition panel This task shows you how to rotate an item reservation by entering into the definition dialog box the number of degrees that you want it to rotate on its vertical axis.. 1. Click on the item reservation. 2. Click Edit in the menu bar and then on the line that corresponds to the item reservation you want to rotate, e.g. "item reservation2.1 object." This displays the Definition dialog box. (You can also enter Cntrl-Enter to display the dialog box.)



3. Enter the degrees in the Rotation space. 4. Click Apply and the item reservation will rotate on its vertical axis.



Using Resources This section tells you how to use resources in various ways.



Place a resource an exact distance from another This task shows you how to place one resource a precise distance from another. 1. Define a plane to use as a temporary reference point from which to measure and then on the resource on distance. Click on the Offset Plane button which you want to place the temporary reference. This will place a blue square on the resource. 2. ). When you Enter an appropriate figure in the steps input box ( are moving your resource, the distance from the second resource will be shown in multiples of the figure in the steps input box. You can use this feature to display the exact distance - for example, if you want to place your resource 11.3 feet from a second resource enter this figure in the steps input box. 3. Click on the resource to be moved. This displays an arrow. Place the mouse pointer on the base of the arrow and drag it. A white square displays. Place this white square on whichever surface you want to use as the point from which distance is measured. The default measuring point is the middle of the resource that is being moved. In the example below the distance is measured from the forward surface of the robot to the blue square.



4. Place the mouse pointer on the arrow. This displays the distance from the blue square to a white square that is displayed. The distance is displayed in multiples of the figure you entered in the steps input box. You can now move the resource to place it a precise distance from the temporary reference plane. Click and drag the tip of the arrow to do this (do not drag the base of the arrow for this function).



Rotate resource using the definition panel This task shows you how to rotate a catalog resource by entering into the definition panel the number of degrees that you want it to rotate on its vertical axis.. 1. Click on the resource.. 2. Click Edit-Definition in the menu bar. This displays the Definition panel. (You can also enter Cntrl-Enter to display the panel.)



3. Enter the degrees in the Rotation space. 4. Click Apply and the resource will rotate on its vertical axis.



Placing Parts in a CATProduct drawing This task shows you how to place a part from a catalog into a CATProduct drawing. 1. Click on the Browser button. 2. Click on the Browse Another Catalog button in the Catalog Browser window that displays, and navigate to the directory where your catalogs are stored. Note: Make sure your Search Order is set to point to the directories where the catalogs are. The directories must be writable. To set the Search Order click Tools - Search Order and add the catalogs.



3. Double-click on the directories until you are in the page where the parts are. Double-click on a part to select it. 4. Click at one or more locations to place the part. Some parts have restrictions attached to them and you will not be able to place them in certain locations. For instance, you will not be able to place an elbow on a straight segment in a run.



To place a part inside an item reservation depress the shift key and click the mouse button. To place a part on a face of an item reservation simply click the mouse button. Some parts have special characteristics. Stretchable parts, such as pipe and duct, when placed in a drawing, will stretch until each end is stopped by a part face or end of segment. They will also be stopped by a bend or corner. Bendable parts, like tubing, act like stretchable parts, with the difference that they can go around bends and corners. Some parts, such as pipe supports and HVAC stiffeners, have "holes" in them through which stretchable and bendable parts can pass.



Placing resources on different planes This task shows you how to place catalog resources on different planes in an area. Normally, when you drag a resource from the catalog and place it on your area, it will be placed on the ground or surface of the area. This procedure shows you how to use the compass base to define a different plane, such as a structure in your area, on which to place a resource. 1. Drag the compass to the plane on which you want to place a resource, such as a table top.The resource will align itself to the Z-axis of the compass: if the Z-axis is pointing straight up the resource will do so too.. . . . 2. Drag a resource from the catalog to your selected location.



3.



When you are done, reset the compass by dragging it to the axis. If you drag a resource onto the area, and the mouse pointer is over an item reservation, then the resource becomes a child of the item reservation.



Using Path Reservations The following items describe how to use path reservations.



Creating a Path Reservation on an Area This task shows you how to create a path reservation on an area. 1. Make the appropriate area active. See Making an Element Active. 2. Select the Path Reservation icon



.



The Routing dialog box is displayed. 3. Define the type of path reservation you want to create.



4.



Define the routing mode for the path reservation: Point-to-point Orthogonal



5. To define Section parameters, do the following:



a. Select the Section type icon. The Section dialog box is displayed.



b. Define the section type and the corresponding parameters for each of them: No Section



Rectangular



Set Point: Height



Width Display: No section True Size Flat



Circular



Set Point Diameter Display No section True Size c. Select OK on the Section dialog box. 6. Optional. Key in a value for the turn radius. 7. Click in the drawing to define the routing points. 8. Double-click the last point to stop routing.



9. that shows at the beginning of the Click on the Close Loop symbol run if you want to create a closed loop run. In a closed loop run the ends of the run are joined.



Routing From the End of a Path Reservation, Boundary, or Run This task explains how to route from the end of a path reservation, boundary, or run. If you route an element with the same type and parameter values as the "source" element (i.e., the element from which the path reservation is routed), you can specify whether the new element you route is a continuation of the source element or a separate element. If you want to use the "Continue" option, be sure that the parent for the source element is active before you begin. 1 Select the Path Reservation icon



.



The Routing dialog box is displayed. 2.



Define the routing parameters. See Creating a Path Reservation on an Area.



3.



Place the mouse pointer at the end of the routable from which you want to route. An arrow will display to show the centerline and the support line as you move the pointer up and down the end of the routable. Select the center or support line and begin routing.



If you want to route the path reservation, boundary, or run as a continuation of the existing element, you must select the arrow that corresponds to the support line. If the new element you route has the same type and parameter values as the element you selected, these options are added to the Routing Dialog box: Continue Routing Create New Route 4.



Select the appropriate Continue option.



5.



Click in the drawing to define the routing points.



6.



Double-click the last point to stop routing.



Branching a Path Reservation This task explains how to route a path reservation that branches from any of these elements in a drawing: Another path reservation Boundary Contour Equipment Run If the "source" element (i.e., the element from which the path reservation branches) is moved or resized, the path reservation is adjusted accordingly. 1. Select the Path Reservation icon 2. 3.



The Routing dialog box is displayed. Define the parameters for the path reservation. See Creating a Path Reservation on an Area. Select the element from which you want to route the path reservation. For a contour, select the edge. For an equipment, select an alignment vector. For path reservations, boundaries, and runs that are displayed with a section, base your selection on the "cues" that are displayed as you move the cursor over the element:



A dashed line is displayed when your cursor is over the center of a section. A solid line is displayed when the cursor is over the support line (defined by the set point of the section). If you want to create a path reservation that "branches" from the end of a path reservation, boundary, or run, see Routing From the End of a Path Reservation, Boundary, or Run.



Routing Using the Compass Base Plane This task shows you how to use the compass to define the plane on which you are routing. This feature allows you to place the compass base on a plane and route on that plane. 1. Drag the compass and place it on the surface on which you want to route. In the illustration below it is one face of an item reservation and you will place a path reservation on it.



2. and do your routing on the surface. Click the Path Reservation button Double-click to end. The path reservation is created.



You can route on any plane on which the compass base can be placed. But you will not be able to route on any surface. You cannot route on the surface of other routables. If you need to route on the surface of a routable then you need to employ free space routing. After you place the compass base on the plane, you can route anywhere in your window and you will be routing on the same plane as the compass base. The illustrations below show one type of free space routing, in which you: Create a boundary and place the compass on a plane. Hide the boundary. Route a path reservation. Show the boundary again with the path reservation on the compass base plane. The last illustration below is a top view showing the path reservation and compass base on the same plane.



Route a run within a pathway This task shows you how to route a run within a pathway. 1. With your pathway model open, click on the Route thru a Pathway button. 2. In the Section dialog box that shows select the type of run, the set point and other options. 3. Click on the pathway in which you want to route your run. This displays set points on the pathway. Select a position for the run by clicking on one of the points, e.g. if you select top center the run will align to the top center of the pathway. You can click Apply in the Run dialog box to see how the run looks and to try different positions. Click OK when you are finished.



Routing from an item reservation This task shows you how to route from an item reservation. 1. button. Click the Run 2. Click on the face of the item reservation from which you want to route. 3. Begin routing.



The point on the item reservation face from which the run will start depends on the set point of the run. In the illustration above the set point is set at Center Center. If the set point was set at Bottom Center the run would have started at the bottom center edge of the item reservation. To change the set point, click on button in the Run dialog box and select a set point from the Section Type the drop down list in the Section dialog box that displays.



Modifying Path Reservations The following items describe how to modify path reservations.



Changing a Section This task explains how to change parameters that control how the section of an element is displayed. 1.



Place your cursor over the element and click the right mouse button.



2.



From the pull-down menu, select the element you want to modify and select Definition. The Definition dialog box is displayed.



3.



Select the Section option. The Section dialog box is displayed.



4. Select No Section or Rectangular Section. If you select Rectangular Section, you can define or change these parameters: Set Point Height Width Display 5.



Click OK on the Section dialog box and OK on the Definition box to complete the change.



Changing the Angle of a Segment This task shows you how to change the angle of a path reservation, boundary, or run segment. 1.



Place your cursor over the element and click the right mouse button.



2.



From the pull-down menu, select the element you want to modify and select the Definition option. The Definition dialog box is displayed.



3.



Place the cursor over the support line for that element and click the right mouse button.



4.



Select Definition from the pop-menu.



5.



The Segment Definition dialog box is displayed. Specify a new value for the Turn Angle. A line is displayed in the drawing to show the new position for the segment.



6. 7.



Click OK on the Segment Definition dialog box. Click OK on the Definition dialog box to complete the change.



Moving Nodes This task shows you how to move the nodes on a path reservation, boundary, or run. In the example below a node will be moved in a pipe run. 1. Place your mouse pointer over the element and click the right mouse button. 2. From the menu that displays, select the element you want to modify, in this case pipe run.1 object, and select the Definition option. This brings up the Definition dialog box, and symbols are displayed on the pipe run to show the location of nodes: asterisks represent non-connected nodes, and Os (circles) represent connected nodes.



3. Do either of the following to move a node: To move a node by keying in coordinates, do the following: a. Right-click the node symbol and select Definition from the pop-up menu. The Node Definition dialog box is displayed. b. Key in new values for X, Y, or Z. c. Click OK in the Node Definition dialog box. To move the node using the cursor, place the cursor over the node symbol and drag it to a new location. See



below.



A line is displayed to show the new location for the segment.



4. Click OK in the Definition dialog box to complete the change. A node will move parallel to the compass base plane, which is normally XY. To move a node vertical to the base, change the compass base to the XZ plane.



Create a closed loop run This task shows you how to modify an existing run in order to create a closed loop run. In a closed loop run the ends of the run are joined. There are two ways of turning an existing run into a closed loop run. Both are explained below. 1. button and continue routing from the end of the run. Click on the Run 2. Click the Continue Routing button in the Run dialog box. 3. Click on the other end of the run when finished. The ends of the run will join and form a loop. 4. In the second method, right-click on the run and, in the drop down box that appears, click on the line that describes the run, in this case Run.1 Object. 5. Another drop down box will display. Click on Close Route.



6. The two ends of the run will join. An open end run and closed loop run are shown below.



Open a closed run This task shows you how to open a closed run. You can only open a closed run at a node. 1. Bring up the Definition dialog box for the run. 2. Click the right mouse button on the node where you want the run to be opened. This will display a drop down box.



3. Click on Open. The run will open at the node.



Managing Systems Ways of creating and managing systems are explained here.



Creating a Network This task shows you how to create a network.. A network is a mechanism for organizing and grouping pathways. You can create networks (such as a Walkway Net) under a distribution system, and then create pathways under each of them. A distribution system is a mechanism for organizing and grouping networks. You can create networks (such as a Walkway Net) under a distribution system, and then create pathways under each of them. A distribution system and network will only display in the specifications tree because they are organizational elements. A pathway will also display in your viewer. 1. The Reservations Click on the Reservations Network button. Network Creation dialog box is displayed.



2. Click on the down arrow and make a selection in the pull-down menu if you want to designate your network as being of a certain type, i.e. walkway.



3. Click OK.



Saving a Distribution System or Network as a separate document This task shows you how to create a distribution system or network as a separate document.. This function is needed if you want to work separately on a component of a larger project. If you save the distribution system or network as a separate document you can open it without having to open the entire project. At the same time it remains part of the larger project. 1. When creating a new Distribution System or Reservations Network check the Create new document option.



2. Enter a file name in the box that displays and click OK. The new document appears in the specifications tree as a child of whichever element you created it under. The icon that shows in the specifications tree next to a system or network created as a separate document is different from that which is not created in a separate document. In the illustration below WasteWater is created as a separate document, Piping System is not.



3. When you save the project a dialog box will ask if you want to proceed with other document save operations. Click OK.



Modifying Routables The following procedures describe how to modify routables.



Positioning a Branch This task shows you how to position a branch routable precisely. . . . .



This function allows you to use the Offset Plane feature to position the Branch at a precise point along the support or center line of the Main. In the illustration below the branch path reservation will be placed in the center. A branch is also referred to as the Slave Connector, and the routable of which it is a branch termed a Master Connector. The two routables must be connected for the function to work. 1. Select the Main routable and click the Offset Plane button. The Main will display nodes at the beginnings and ends of segments and a square (section detail) in the center of segments.



2. Move the mouse pointer to the Main Routable - a white square shows. Snap the white offset plane square to any of the nodes or section detail squares and click the left mouse button. A blue square will appear. See Using Offset Planes for more information.



3. Click the right mouse button on the Branch. In the menu that displays, select the line that corresponds to the Branch element, in this case path reservation2 object, then click Definition in the pop-up menu. This displays the Definition dialog box. 4. Click and drag the support line toward the blue square. A label will display the distance. Release the button when it reads 0 ft and click OK on the Definition dialog box. The Branch path reservation will assume the new position.



To place a routable at a precise distance from an end or a node, snap the offset plane to that node or end. Then enter the distance in the step input box.



Follow the steps above to move the Branch and click OK on the Definition dialog box when the required distance is reached.



Connecting Routables This task shows you how to connect a routable to another routable. Routables are path reservation, space reservation, boundary, or run. There are two kinds of connection: branch and end-to-end. In a branch connection the end of one element connects to the middle of another. In an end-to-end connection two ends connect to each other. In the examples below path reservations A and B will be connected to each other, first as a branch and then as an end-to-end connection.



When you connect two elements one becomes the Slave while the other becomes the Master. In the example above, if you make the one on the right the Slave and the one on the left the Master, then, after you connect them, the Slave will follow the Master to maintain the connection if you move the Master. 1. Place the mouse pointer over the element you want to designate the Slave and click the right mouse button. 2. From the pull-down menu that displays, select the element you want to modify, in this case Path Reservation, and select the Connect Routes option. (You can also click Edit and then the element, in this case Path Reservation, and select Connect Routes.) 3. Select the Master Connector. To select, move your mouse pointer over the path reservation you wish to designate the Master and click on either the support or center line connector. See Information below.



When you move the mouse pointer over the path reservation you will see two lines alternatively, as you move the pointer from bottom to top. The solid line is the support line connector, and the dashed line is the center line connector (illustrated below). The second path reservation will connect to whichever line you select. Select the line by clicking.



4. Select which end of the Slave you want to connect to the Master. The Slave will connect with the Master after you click.



The two elements will connect at the point where the two support or center lines would intersect. If you want to change the position then see Moving Nodes. 5. To make an end-to-end connection replace Step 3 above with the following: Select the Master Connector. To select, move your mouse pointer over the path reservation you wish to designate the Master and click on the arrow that displays at whichever end you want to connect. As you move the pointer up and down the arrow will move, depending on whether the pointer is over the support or center line connector, as explained above.



Disconnecting Routables This task shows you how to disconnect a routable that is connected to another routable. Routables are path reservation, space reservation, boundary or run. 1. If it is a branch connection then select the Slave element, in this case a path reservation. If it is an end-to-end connection then you can select either Master or Slave. 2. Click the right mouse button on the element you selected. From the pull-down menu that shows, select the element you want to modify, in this case path reservation, and select the Definition option. The Definition dialog box is displayed, and an O (circle) node symbol is displayed on the path reservation where it is connected to the other element. In the illustration below the mouse pointer is pointing to it.



3.



Right-click the node symbol. A pop-up menu shows. Select Disconnect.



4.



Click OK on the Definition dialog box. The two elements are disconnected.



Break Run at a Branch This task shows you how to break a run at a branch. There may be times when you want to move all the segments of a connection at the same time. Breaking runs at branch intersections is one way. When you break runs at branch intersections you create what is called a star connection. In this type of connection (recognizable by a square or diamond-shaped symbol), all the segments joined at a connection will move if you move the connection. In a master-slave connection, the slave will maintain a connection with the master if you move the master. The illustrations below show 1) a run with a star connection; 2) the star connection is moved by dragging with the mouse; and 3) all nodes connected to the star connection move to the new star connection location in order to maintain that connection.



1. Click on the Star Connection button. 2. Click on the routable, system or network you want to convert to star connection. A branch connection symbol connections in the selected element.



will display at all branch



A pop-up panel will ask: OK to continue? Click Yes.The connection will be converted. The illustrations below show a branch connection converted to a star connection, with the diamond-shaped star connection showing.



The illustration on the left shows that the main section consists of one segment. But after conversion to a star connection it is broken at the connection into two segments.



Convert Star Connection to master-slave type This task shows you how to convert a star connection to a master-slave type of connection. 1. Display the Definition dialog box for the run. To do this click Edit in the menu bar and then on the line that corresponds to the run, e.g. "Path Reservation.1 object." This displays the Definition dialog box. (You can also enter Cntrl-Enter, or click the right mouse button on the run, to display the dialog box.)



2.



Place the mouse pointer on the diamond-shaped star connection and click the right button. This will bring up a pop-up panel. Click on Convert to master/slave connection.



Advanced Tasks The advanced tasks for laying out a design using the System Space Reservation workbench are listed below.



Using Layout Tools The following procedures describe the tools available in System Space Reservation for advanced layout functions.



Using Offset Planes This task shows you how to define a plane to use as a temporary reference for positioning other elements. 1. . Select the Offset Plane icon 2. Define the reference plane by doing the following: a. Place your cursor over a geometric element that defines the plane (e.g., a construction plane, boundary, area contour, item reservation). As you move the cursor, a small white rectangle is displayed to show the selectable planes, as shown below.



If you do not see the white rectangle, zoom out from the drawing. The white rectangle cannot be displayed if the element under your cursor is displayed too small. b. Click to select the plane. The white rectangle changes to a blue rectangle, and remains displayed on the reference element, as shown below.



The reference plane can now be used as a reference to position other elements.



Mirroring Elements This task shows you how to move one or more elements to the opposite side of a selected plane, as a mirror image. It also shows how to copy one or more elements to the opposite side. 1. Select the element(s) you want to move. (You can also select after Step 2.) 2. Click the Mirror icon . 3. The Reference panel will display if you already have a reference plane defined (by having used the offset plane command).



Click the New Reference Plane button and follow Step 4 if you want to define a new reference plane. Follow Step 4B if you want to use the existing reference plane. The Reference panel will not display if you do not have a reference plane already defined. 4. Define a reference plane across which to mirror the element by doing the following: . Place your cursor over a geometric element that defines the plane (e.g., a construction plane, boundary, area contour, item reservation). As you move the cursor, a small white rectangle is displayed to show the selectable planes, as shown below.



If you do not see the white rectangle, zoom out from the drawing. The white rectangle cannot be displayed if the element under your cursor is displayed too small.



b. Click to select the plane. The selected elements are mirrored to the other side of the plane, as shown below.



5. To Mirror and Copy the elements, follow the steps outlined above and then click the Mirror and Copy . The selected elements will be copied to the other side of the plane. In the illustration icon above, the selected elements will stay where they are and two similar elements will be added to the other side of the plane.



Rearranging Elements in the Specification Tree This task shows you how to transfer elements in your layout from one level of the specification tree to another. 1.



Make the appropriate element active.



You must make active an element that is at least one level higher than both the source element (i.e., the one that is being transferred) and the target element.



For example, in order to transfer ArrBox5, ArrBox6, ArrBox7, ArrBox 8, and ArrBox9 to ArrArea3, shown below, ArrArea1 or Product1 must be active.



2. Select the elements you want to transfer.



3.



Select the Transfer Nodes icon . 4. Select the element to which you want the elements transferred.



The target element must also be a child of the active element.



The elements you select in step 2 become children of (i.e., subordinate to) the element you select in step 4.



Moving Multiple Elements This task shows you how to move several elements at the same time.



You can move catalog resources as well as the following elements: item reservation, area, space reservation, run reservation, path reservation and boundary reservation. 1. Select the resources or elements you want to move. You can do this by placing the mouse pointer on each one and clicking the left button while holding down the Ctrl key. Another way is to hold down the left mouse button and drag the mouse pointer. Place the rectangle that shows around the elements you want to select. There are other selection methods also.



2. Drag any of the elements or resources and all selected elements and resources will move. You can drag an element or resource by placing the mouse pointer on the dot that shows in the center of selected elements or resources, holding down the left mouse button and moving the pointer to where you want to place the selected elements.



Changing the Properties of Multiple Elements This task shows you how to change the properties of several elements at the same time. The elements whose properties can be changed are: item reservation, space reservation, area, run reservation, path reservation and boundary reservation. 1. Select the elements whose properties you want to change. You can do this by placing the mouse pointer on each one and clicking the left button while holding down the Ctrl key. Another way is to hold down the left mouse button and drag the mouse pointer. Place the rectangle that shows around the elements you want to select. There are other selection methods also. See Infrastructure.



2. Click Edit-Properties to bring up the Properties dialog box.



3. Make your changes and click OK or Apply. You can also make changes to one of the elements instead of all. Click on the down arrow next to the Current Selection box. This will display a drop down list of all the elements you selected. Select the one you want to make changes to. You may need this if, for instance, you have two areas but want to change the properties of one area only.



Performing an Inclusion Analysis This task shows you how to find out if elements that are logically contained in an area (in the specification tree) are also physically located within the contour of the area (in the drawing). 1. Right-click the area on the specification tree. 2.



From the pull-down menu, select the area object and select the Space Inclusion option.



The Inclusion dialog box is displayed.



3.



4.



Define the parameters for the analysis: Type Inclusion reports which elements are partially inside or touching the selected area. Inclusion No Contact reports which elements are completely outside of the selected area. Scope: 1 Level checks the inclusion status of elements one level down from the area in the specification tree. All levels checks the inclusion status of all elements below the area in the specification tree. Select OK. The Results Window is displayed.



You can select entries in the report to highlight the corresponding element in the drawing.



Distributing Elements This task shows you how to distribute elements within parameters that you define. 1. Select the elements you want to move. 2. Select the Distribute icon . 3. Define a reference plane for the distribution by doing the following: a. Place your cursor over a geometric element that defines the plane (e.g., a construction plane, boundary, area contour, item reservation). As you move the cursor, a small white rectangle is displayed to show the selectable planes, as shown below. A line perpendicular to the rectangle shows the direction in which the distribution would be performed. If you do not see the white rectangle, zoom out from the drawing. The white rectangle cannot be displayed if the element under your cursor is displayed too small.



b. Click to select the plane.



The selected elements are distributed along the line perpendicular to the plane, as shown below.



Tasks for Space Reservations The following tasks describe advanced space reservation routing.



Routing Path Reservations With a Slope This task shows you how to route a path reservation with a slope. 1. Click the Path Reservation icon



.



The Routing dialog box is displayed. 2. Click the Slope icon 3.



.



Key in a value for the slope and press Enter.



4.



Click in the drawing to define routing points, changing the slope as needed.



5.



Double-click the last point to stop routing.



Routing Path Reservations in Any Direction This task shows you how to route a path reservation in any direction. 1. Click the Path Reservation icon



.



The Routing dialog box is displayed, and crosshairs track the movement of your cursor in the drawing. 2. Click the Directional icon 3.



.



The compass is displayed in the drawing. Define the first point to begin routing.



If the first point is a free point, the default direction for routing is along the X axis. If the first point is the end point of a line, the default direction is along that line. 4.



Do either of the following to change the direction for routing: Press the Shift key repeatedly until the desired axis is highlighted. Select and drag an axis to rotate it. The angle at which the axis is turning is displayed.



5.



Click in the drawing to define additional routing points, changing the direction for routing as needed.



6.



Double-click the last point to stop routing.



Route a run at an offset of a routable This task shows you how to route a run at an offset of a routable. This function allows you to create a run paralleling an existing run, a defined distance apart. 1. Click the Create an Offset Route button. 2. Select a segment of the run to which you want an offset. The compass is placed on the segment. 3. The direction in which the Z axis of the compass is pointed determines where the new run will be placed: you can place the new run or runs to the inside, to the outside or stacked on top of the existing run by adjusting the compass. 4. Enter your options in the Run dialog box. 5. Click either the Constant Radius or Constant Clearance button. If you click the Constant Radius button the radius of the turns will be maintained but the offset may vary. If you click the Constant Clearance button the offset will be maintained but the radius of the turns may change. Click OK. The new runs will be created. A negative offset may be entered to offset in the opposite direction to the compass Z direction. In the illustration below the runs have been created with the Constant Clearance option.



Route a run along a spline This task shows you how to route a run along a spline. 1. Import the model which contains the spline into the Systems Routing workbench.



2. Click on the Route from Spline button. 3. Select type of run and enter other options. Note: The SAG option is used to define the maximum distance a segment can be from the spline. The run that is created consists of straight segments, as you can see in the illustration below. The smaller the SAG number entered, the closer the run will resemble the spline. But this will also cause more segments to be created. 4. Click on the spline. The run is created.



Fixing broken routables This task shows you how to fix - or rejoin - routables in which segments have become separated. In the illustration below the dotted line the broken routable indicator - shows that a run has become separated at that point.



You can re-join the run in one of several ways, depending on the nature of the break and your requirements. The methods are as follows:



1. Bring up the Definition dialog box for the run, then place the mouse pointer over the broken routable indicator and click the right mouse button. This will display a pop-up menu. Click Create Segment. 2. Bring up the Definition dialog box, then drag one of the segment handles to re-join the run. 3. Bring up the Definition dialog box. An arrow will display at each end of the broken routable indicator. Drag one of the arrows (depending on circumstances) to re-join the run. In the illustration below, one segment of the run has been moved to connect to the portion of the run still connected to the pump.



4. In certain cases you will see the Auto Route option beneath the Create Segment option in the pop-up menu (See Step 1). This happens when a segment connecting two parallel routables (which are on different X-Y planes) is broken. Select Auto Route. The Auto Route dialog box will display.



Click on the Toggle button. Options for re-joining the run will be shown as a dotted line. Click OK to make your selection.



Customizing This section describes the ways in which you can customize the System Space Reservation workbench.



Customizing the Dictionary of Types This section explains how to customize the list of types that are displayed when you create any of these elements: Areas Routing elements Item reservations Distribution systems Network reservations Grids A basic dictionary of these element types is provided with the product. You can add entries to or delete entries from the basic dictionary, or you can replace it entirely. The example and procedure below provide details.



Customizing the Dictionary of Types: Example The capability for customizing the Dictionary of Types is available only on the Windows NT platform. To customize the dictionary of element types provided with the Plant Layout product, you need to run two scripts: PSLNomenAccessFeat.CATScript reads the existing dictionary and writes it to a preformatted Microsoft* Excel file. PSLNomenBuildFeat.CATScript takes a properly formatted Excel file and generates a new dictionary. The example below illustrates how the type Work Cell is added to the list of types available when you create an area.



Customizing the Dictionary of Types: Procedure This task explains how to customize the list of types that are displayed when you create any of these elements: Areas Routing elements Item reservations Distribution systems Network reservations Grids



The capability for customizing the Dictionary of Types is available only on the Windows NT platform. To accomplish this procedure, you must have installed Microsoft Excel 97 or later version. You should be familiar with the basic editing features of Excel, as well as with the file navigation and file editing capabilities of your system. 1. Copy the following files from \intel_a\code\command to a drive or directory for which you have read and write permissions: PSLNomenAccessFeat.CATScript PSLNomenBuildFeat.CATScript PSLNomenAccessFeatTemplate.xls 2. Start CATIA. 3. From the menu bar, select Tools -> Macro -> Macros. 4. Select Macro In: External File. 5. Select the Select button, and use the Windows dialog box to navigate to the appropriate file. 6. Select the file PSLNomenAccessFeat.CATScript and select OK. 7. Edit PSLNomenAccessFeat.CATScript as follows: Define the path strEXCELTemplateFileName to point to the directory to which you copied the files in step 1.



8. Save and close the file.



9.



Select Run. Microsoft Excel is launched, and a file is created.



10. Edit the Excel file to add or delete entries, as appropriate. 11. Save the Excel file with a unique name. 12. From the CATIA menu bar, select Tools -> Macro -> Macros again. 13. Select the Select button, and select the file PSLNomenBuildFeat.CATScript. 14. Edit PSLNomenBuildFeat.CATScript as follows: Define the input path strEXCELInputFileName to point to the Excel file you saved in step 11. Define the output path strCATIAV5FeatOutputFileName to point to \intel_a\resources\graphic\CATArrNomenclature.feat. If you do not have write permissions for this output path directory, you can define a temporary location. Contact your system administrator to move or copy the file to the correct location after it has been created. 15. Save and close the file. 16. Select Run. The output file is created in the directory you specified. If you defined a temporary location for the file, it must be moved or copied to \intel_a\resources\graphic\CATArrNomenclature.feat before the modifications can take effect. The modifications will take effect when you restart CATIA.



Customizing the Specifications Tree This section shows ways of customizing the specifications tree.



Customizing the Specifications Tree Display This task shows you how to turn on and turn off the display of certain objects in the specifications tree. . . If you are working on a large project then turning off the display of some objects in the specifications tree may reduce visual "clutter" in the tree. Turning off an object in the tree does not remove it from your design or layout. In the first example below, the tree shows the object "Equipment Reservation.1." In the second example it has been removed from the tree but continues to show in the layout.



Changes made in the specifications tree remain effective until you change them again. 1. Click Tools-Options in the menu bar. 2. In the Options dialog box that displays, select Product in the left column, then scroll through the tabs and click on Plant Layout. This displays a list of seven objects, two of which, by default, are not checked (Contours and Construction Planes).



3. Uncheck the objects you do not want displayed in the specifications tree. 4. Check the objects you want to display in the tree. 5. Click OK. 6. Refresh the specifications tree by expanding it again.



Creating a Catalog The following three tasks are required for creating a catalog that can be used to place parts in the System Space Reservation product.



Creating Parts This task explains how to create parts for the Systems Routing Product.



1. Create the geometry for the part. Use the CATIA Version 5 Part Design product to create the geometry. See the CATIA Version 5 Part Design User's Guide for instructions about how to use this product.. If you want to be able to place the part parametrically, go on to step 2. For fixed-sized parts, save the part as a CATPart document and skip to step 5. If you want to use the same set of geometry for different sizes of the same type of part, go on to step 2. 2.



Define parameters for the geometry. When you define parameters, you must adhere to the following naming conventions to ensure that the part can be sized correctly when it is placed. The values for these reserved parameters are derived from the run on which the part is placed. CATRouOutsideDiameter -- outside diameter of the part if it is placed on a cylindrical run CATRouOutsideHeight -- overall height of the part if it is placed on a rectangular run CATRouOutsideWidth -- overall width of the part if it is placed on a rectangular run CATRouFaceToFaceLength -- overall length of a stretchable part such as pipe or duct CATRouAngle -- turn or branch angle of parts such as an elbow or tee CATRouTurnRadius -- bend radius of a part such as an elbow or horizontal turn You may also add two other reserved parameters to your part as User attributes. CATRouPartNumber -- a string parameter. This parameter will contain the part's part number. CATRouSize -- a string parameter. This parameter will contain a character string representing the nominal size of the part. It can be used instead of CATRouOutsideDiameter/Height/Width. All of these parameters do not need to exist on every part. Define only those parameters that apply to the part you are creating. For example, to create a



straight cylindrical part, you would define only the CATRouOutsideDiameter and CATRouFaceToFaceLength parameters. Optionally you can define CATRouSize instead ofCATRouOutsideDiameter. In addition to the reserved parameters, you may define other parameters on the part. These parameters must also be included in the design table if these parameters have different values for different sizes when the part is placed.. 3. Save the part as a CATPart document. 4. Create the design tables. See the CATIA Version 5 Infrastructure User's Guide for detailed instructions on how to create a design table and associate it to a part for which you must use external table files. Excel files are easy to edit, but using tab-delimited text files instead of Excel files makes parts placement more efficient. You can build and edit your tables in Excel, then convert the file to a tab-delimited text file, and attach the text file to your part document. Design tables are used to manage the allowable combinations of values for the parameters of a part. You must create tables with the following reserved names in order for them to be recognized by the Systems Routing product. (Except external files - see below.) CATRouFixedSize This table must contain those reserved run parameters described after step 2 which you want as fixed size parameters. Your table may contain one or more rows of values - each row generally represents a specific fixed size part. The first row contains the parameter names. They may be reserved parameters or other parameters. Those that are reserved run parameters are used as a key to select the appropriate row in the table. When the part is placed, the values for these parameters are derived from the run. If an exact matching of values on the run and values in the table is not found then the row with the closest match is used. This table must also contain parameters not associated with the run, if any, that are needed to complete the geometry definition. Generally, you may wish to include in your table CATRouPartNumber as the first parameter, CATRouSize as the second, then the other reserved run parameters, then the other part parameters. CATRouParametricSize This table is used to define parameters that can be dynamically



defined by the run. All parameters in this table must be defined on the run. When a part is placed, the values for these parameters are retrieved from the run and used to size the geometry. If you use external files they can have any name. But when you create the design table in the part document it must have one of the reserved names. 5. Define connector data on the part by following the steps below. Connector data is used to properly position, align, and orient parts when they are placed on a run. In addition, it is used to properly position, align, and orient a run that is started from a part. . Start a new Assembly Design CATProduct document. b. RIght-click the Product in the specification tree and select Existing Component. c. d. e. f. g.



The Insert an Existing Component dialog box is displayed. Find and select the CATPart document you saved. Double-click the part in the Specification Tree to make the part active. Enter the Assembly Design workbench. On the menu bar, select Tools -> Publication Management... . Use the Publication Management facility to add connector data.



See the CATIA Version 5 Assembly Design User's Guide for the specific instructions about using the Publications Management facility. h. Save the CATProduct document. When you define connector data for a part, you must adhere to naming conventions to ensure that the part will be correctly positioned, aligned, and oriented. When placing a part onto a run or attaching one part to another, connector data is used to properly position, align, and orient the part. When routing a run from the part, connector data will be used to locate the start of the run and ensure proper alignment and orientation of the run.



All About Connector Data There are three types of connector data: Face data, Alignment data and Orientation data. Face data is generally defined using a face of the part, such as the circular face at the end of a pipe. Alignment data is generally defined using a line, such as a no-shown line along the centerline of a pipe. The actual connection point location is the intersection between the face plane and the alignment line. They do not have to actually intersect – the system will find the intersection location between the infinite line and the infinite plane. The face does not have to be the actual diameter face or width-height face. Orientation data is generally defined using the xy plane, or another plane or face in the part, to define an "up" direction. Face Connector Data. To define the directional planar location for each connection face of the part. If the part is stretchable, two connection face definitions will be used to define the extremity locations of the part. For routing from the part, a connection face (along with the corresponding intersecting alignment line) will be used to define the start point of the run. You should select one of the faces in the part to define a face connection. Select a face that faces outward from the part, in the direction of routing or other attached parts. You must define a face for each connection end of your part. The pre-defined names for face connector data include the following: CATRouFace – for the first or only connection face of a part. CATRouFace1 (same as CATRouFace) – for the first connection face of a part. CATRouFace2 – for the second connection face of a part. CATRouFace3 – for the third connection face of a part. CATRouFace4 … 5 … 6 … etc. CATRouHole CATRouHole1 CATRouHole2 … 3 … 4 … etc. Hole connections are a unique type of face connection. Whereas a pipe or tube may stretch to a face connection, a pipe or tube may pass through a hole connection. This is useful for placing such parts as tubing clamps along a run without cutting a tube. Alignment Connector Data. To define the alignment at each of the face



connections of this part. For placement of an attached part or routing from the end of a part, this data will define the alignment. You will generally select a line for the alignment connector data, which may likely be no-shown. But you may also select a cylinder, and its implied centerline will become your alignment data. Each part connection face does not necessarily need its own alignment line. A pipe and a valve might have one alignment definition, but an elbow would need two alignment definitions. A tee needs two alignment definitions, but could have three. A cross with four connection ends needs at least three alignment definitions. When the number of alignment definitions is less than the number of connection ends, it must be only one less, and alignment1 corresponds with face1 and face2, and alignment2 corresponds with face3. The pre-defined names for alignment include the following: CATRouAlignment – for the first or only alignment line of a part. CATRouAlignment1 (same as CATRouAlignment) – for the first alignment line. CATRouAlignment2 – for the second alignment line of a part. CATRouAlignment3 … 4 … etc. Other pre-defined names for alignment include the following: CATRouTop – for top-center CATRouCenter – for center (same as CATRouAlignment) (center is default alignment) CATRouBottom – for bottom-center CATRouLeft – for left-center CATRouRight – for right-center CATRouTopLeft CATRouTopRight CATRouBottomLeft CATRouBottomRight including …1, …2, …3, …4, etc Orientation Connector Data. To define the orientation/clocking of a part when placed on a run. Many parts direction, such as horizontal trays and power & free conveyors, require a well-defined "up". Round ducts and pipes do not require a well-defined "up" direction, they can rotate. Rectangular ducts do not have a



strict "up" direction, but do have four usual orientations corresponding to each of the four sides. Tubing elbows can flip upside down in order to swap end1 and end2, since they often have different end styles. Generally, parts are built in such a way that the Z direction is up. If this is the case, then generally the XY plane can be used to define the orientation. The orientation plane and the face plane should not be parallel. For a particular connection end, you should not define an alignment going up in the Z direction and an orientation plane pointing up in the Z direction. Rarely will an "Orientation2" be needed. Some tubing clamps use an orientation2 because they have one alignment along the tube alignment and another alignment going up through the bolt hole (for stacking). Tray vertical elbows and vertical tees also need an orientation2.



The pre-defined names for orientation include the following: CATRouUpOnly – the part has a well-defined "up" direction. (Tray) CATRouUpOnly1 – same as CATRouUpOnly CATRouUpOnly2 … 3 … etc. CATRouCircular – the part has no strict "up" direction. (Pipe) CATRouCircular1 – same as CATRouCircular CATRouCircular2 … 3 … etc. CATRouRectangular – the part has four orientations that can be "up". (Rect duct) CATRouRectangular1 – same as CATRouRectangular CATRouRectangular2 … 3 … etc. CATRouOrientation – same as CATRouUpOnly (up-only is default orientation) CATRouOrientation1 – same as CATRouUpOnly1 CATRouOrientation2 … 3 … etc. – same as CATRouUpOnly2 … 3 … etc. Sample Publication Management combinations for connector data: A pipe or piping valve: CATRouFace1 CATRouFace2 CATRouAlignment CATRouCircular



A piping cap: CATRouFace CATRouAlignment CATRouCircular A rectangular duct elbow: CATRouFace1 CATRouFace2 CATRouAlignment1 CATRouAlignment2 CATRouRectangular An OPF conveyor track: CATRouFace1 CATRouFace2 CATRouBottom CATRouOrientation A tray horizontal tee: CATRouFace1 OR CATRouFace1 CATRouFace2 CATRouBottom1 CATRouBottom1 CATRouFace2 CATRouFace3 CATRouBottom2 CATRouBottom2 CATRouFace3 CATRouOrientation CATRouBottom3 CATRouOrientation A round duct cross: CATRouFace1 OR CATRouFace1 CATRouFace2 CATRouAlignment1 CATRouAlignment1 CATRouFace2 CATRouFace3 CATRouAlignment2 CATRouAlignment2 CATRouFace3 CATRouFace4 CATRouAlignment3 CATRouAlignment3 CATRouFace4 CATRouCircular CATRouAlignment4 CATRouCircular



A tubing clamp: CATRouHole1 OR CATRouHole1 CATRouHole2 CATRouAlignment1 CATRouAlignment1 CATRouOrientation1 CATRouOrientation1 CATRouHole2 CATRouFace3 CATRouAlignment2 CATRouAlignment2 CATRouOrientation2 CATRouOrientation2 CATRouFace3 CATRouFace4 CATRouAlignment3 CATRouAlignment3 CATRouOrientation3 CATRouOrientation3 CATRouFace4 CATRouAlignment4 CATRouOrientation4



Creating a Catalog This task explains how to create a catalog. The Catalog facility is a standard facility provided with the V5 CATIA Product line. For detailed information regarding Catalogs, please see the CATIA Infrastructure documentation - Advanced Tasks - Using Catalogs. Information that is particular to this product is given here. To properly learn to create a catalog you must read the document referenced above. 1. Open the Catalog Editor by clicking on Start-Infrastructure-Catalog Editor. The Catalog Window opens with a basic catalog structure in the left column. Catalogs are created analogous to books, with the book being at the top level, chapters under it, and, if necessary, sub-chapters under them, and with pages at the lowest level. Each page contains references to one or more parts. You can also assign keywords to the parts, to define where the part can be placed i.e. stretchable part, bendable part and so on. The illustration below shows the Catalog Editor. The column to the left is where your chapters and pages are displayed. The column to the right will display parts when you click on a page. It will also display keywords, if you have assigned them.



2. Rename the catalog and chapter and add as many chapters and pages as you want to. You can add these later also. Save and close the window and reopen it to see your changes. To rename the chapter, right-click on it and bring up the Definition dialog box. To rename the book, save the catalog, at which time you can rename it.



3. Add keywords to your pages. In the System Space Reservation workbench you have a choice of two keywords to select from: PlacementType and LoadType. These are further explained below. Assigning keywords is optional. To assign a keyword, select the page, click on the Create button, and enter your options. Enter one of the two supported keywords in the Name field, and select a type from the drop down Keyword list under Type.



4. button to bring up the Description Add a part definition to the page. Select the page and click the Create Description Definition dialog box. Click the Keyword tab, select the Name line and enter the part name in the Value field. The part name will be displayed in the right column.



5. Assign keyword values to the part definition, in the Description Definition dialog box. Keywords have certain values (listed below) which help you place the part. You do this by clicking the Keyword tab, selecting the LoadType (or other keyword) line, and entering the value in the Value field.The part names, keywords and values will display in the right column, as illustrated below.



6. Link your part to an actual CATPart or CATProduct document. You do this also in the Description Definition dialog box by clicking the Reference tab and then the Select Document button. This will bring up the SelectFile dialog box. Keywords Explained System Space Reservation supports two types of keywords: PlacementType and LoadType. The PlacementType keyword will aid the user during parts placement – an elbow cannot be placed along a run segment, and a pipe cannot be placed at a run corner node. These restrictions can be defined using the PlacementType keyword. For some types of pages you will want to add a string keyword called "LoadType". The LoadType keyword allows you to specify whether or not a parameter value of a part can be modified after placement. The two types of LoadType are: NewReference (the default: part parameters can be modified after placement), and SameReference (for fixed-size, part parameters cannot be modified after placement). The values defined for PlacementType are as follows: FreeSpaceOnly



Place in free space.



Equipment



Place in free space.



Stretchable



Pipes, tubes, ducts, ladders, etc.



Bendable InLine Turn Branch BranchComplex



Pipe with bends, tube with bends. Valves, flanges, dampers, etc. Elbows, turns, etc. Tees, crosses, lateral tees, switches, etc. Wyes, forks, etc. (at least 3 alignments)



BranchMultiElevation Transfers, multi-level tees, etc. Reducer Terminus



Reducers, transitions, etc. Caps, end plates, vents, etc.



Offset Support



Offsets, oggees, etc. Piping supports, tubing clamps, etc.



If you do not specify PlacementType, the default placement type is "place anywhere" – in free space, along a run, at a run node, or at the end of a run. If you do not specify LoadType, the default load type is "NewReference".



Making a Catalog Accessible This task explains how to specify the location of a catalog so that it can be accessed from the Systems Routing product in order to place parts. 1. From the menu bar, select Tools -> Search Order. 2.



The Search Order dialog box is displayed. Specify a search order that points to the directory in which the catalog is located. For specific instructions about how to specify a search order, see the CATIA Version 5 Infrastructure User's Guide (Workbench Description -> Menu Bar -> Tools -> Creating a Document Search Order).



Workbench Description The CATIA System Space Reservation workbench includes the following toolbars:



System Space Reservation Toolbar



General Design Toolbar



Catalog Browser



Update the System



General Environment Toolbar



System Space Reservation Toolbar The System Space Reservation Toolbar contains the following tools:



Reservations Network. See Creating a Network See Creating Path Reservations and Modifying Path Reservations. See Using Item Reservations See Route a Run Along a Spline. See Route a Run at an Offset of a Routable. See Route a Run within a Pathway.



General Design Toolbar The General Design Toolbar contains the following tools:



See Breaking Run at a Branch See Mirroring Elements.



See Mirroring Elements See Rearranging Elements in the Specification Tree. Align Sides - See Aligning Elements. Align Center - See Aligning Elements Distribute - See Aligning Elements Rotate to Align - See Aligning Elements



General Environment Toolbar The General Environment Toolbar contains the following tools:



See Changing the Current Axis.



See Using Offset Planes. See Using a Step Grid for these icons: Snap to steps off current axis Snap to steps off last position Snap to XY construction planes Snap to all construction planes Snap to elevation (Z) construction planes Snap to Drafting elements See Making an Element Active.. See Making an Element Active for these icons: Activate parent Activate area



Glossary C chamfer



A cut through the thickness of the feature at an angle, giving a sloping edge. child A status defining the genealogical relationship between a feature or element and another feature or element. For instance, a pad is the child of a sketch. See also parent. constraint A geometric or dimension relation between two elements.



D draft angle A feature provided with a face with an angle and a pulling direction. distribution A mechanism for organizing and grouping networks and pathways. system



F feature fillet



A component of a part. For instance, shafts, fillets and drafts are features. A curved surface of a constant or variable radius that is tangent to, and that joins two surfaces. Together, these three surfaces form either an inside corner or an outside corner.



G groove



A feature corresponding to a cut in the shape of a revolved feature.



H hole



A feature corresponding to an opening through a feature. Holes can be simple, tapered, counterbored, countersunk, or counterdrilled.



M mirror



A feature created by duplicating an initial feature. The duplication is defined by symmetry.



N node



Symbols that mark the end of segments in routables. They can be used to move or manipulate segments.



P pad parent



part part body pattern pocket profile



A feature created by extruding a profile. A status defining the genealogical relationship between a feature or element and another feature or element. For instance, a pad is the parent of a draft. A 3D entity obtained by combining different features. A component of a part made of one or several features. A set of similar features repeated in the same feature or part. A feature corresponding to an opening through a feature. The shape of the opening corresponds to the extrusion of a profile. An open or closed shape including arcs and lines created by the profile command in the Sketcher workbench.



R reorder rib



An operation consisting in reorganizing the order of creation of the features. A feature obtained by sweeping a profile along a center curve.



S scaling set point



shaft shell sketch slot split stiffener



An operation that resizes features to a percentage of their initial sizes. The alignment point for a boundary or path reservation for which a section is defined. The set point determines, for example, whether the routing line drawn for a boundary represents the bottom left, bottom right, or bottom center of the boundary. There are three possible set points for a boundary and nine possible set points for a path reservation. A revolved feature A hollowed out feature A set of geometric elements created in the Sketcher workbench. For instance, a sketch may include a profile, construction lines and points. A feature consisting of a passage through a part obtained by sweeping a profile along a center curve. A feature created by cutting a part or feature into another part or feature using a plane or face. A feature used for reinforcing a feature or part.



T turn angle The angle formed between two imaginary lines that are perpendicular to adjacent segments. stiffener



A feature used for reinforcing a feature or part.



Index A axis changing the current axis



B branch positioning breaking run at



C current axis changing



D dictionary of types customizing



E elements changing properties making active moving multiple equipment reservation, create



G grid using



I inclusion report item reservation creating moving resizing rotating



M mirroring elements



N network creating saving in separate document nodes moving



O offset planes



P path reservations creating branching routing from the end



R resource measuring distance between placing placing on different plane rotate with definition panel routables connecting disconnecting routing at a slope at an offset of a routable in any direction with the compass base plane within a pathway



S section changing segment changing angle specifications tree rearranging elements star connection convert to master-slave step grid using



T toolbars System Space Reservation General Design General Environment
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